# SPM8 Processing Manual

## Table of Contents

**SPM8 Processing Manual** ................................................................................................. 1  
**SPM Introduction** ............................................................................................................. 3  
SPM Introduction ....................................................................................................................... 3  
Using SPM .................................................................................................................................. 6  
Order of Preprocessing ............................................................................................................... 7  
**PREPROCESSING** ............................................................................................................... 9  
Basic IO ...................................................................................................................................... 9  
Convert files to SPM format ...................................................................................................... 9  
Slice Timing ............................................................................................................................... 10  
Realignement ............................................................................................................................. 10  
Coregistration ............................................................................................................................ 11  
Segmentation ............................................................................................................................. 11  
Normalization ............................................................................................................................ 12  
Smoothing ................................................................................................................................. 13  
**SUBJECT LEVEL ANALYSIS** .............................................................................................. 14  
1\(^{st}\) level analysis .................................................................................................................. 14  
  * fMRI model specification .................................................................................................. 14  
  * Model estimation ............................................................................................................. 16  
  * Contrasts: ........................................................................................................................ 16  
  * Printing Results ............................................................................................................... 17  
Multiple conditions file for 1\(^{st}\) level design specification .................................................... 17  
  * Creating a Multiple condition file .................................................................................. 17  
  * Examples of Matlab scripts for getting onsets into multiple conditions file .................. 19  
**GROUP ANALYSIS** .......................................................................................................... 21  
2\(^{nd}\) level analysis ................................................................................................................ 21  
  * Specify Design ................................................................................................................ 21  
  * Model estimation ............................................................................................................ 22  
  * Contrasts ........................................................................................................................ 22  
Results ...................................................................................................................................... 22  
  * Viewing Results ............................................................................................................. 22  
  * Significance Table ........................................................................................................... 23  
  * Overlay Images .............................................................................................................. 23  
  * Plot .................................................................................................................................. 24
Batch Script Processing .................................................................................................................. 25
GIU Batch ........................................................................................................................................ 25
Script Batch (Advanced) .................................................................................................................. 26
Preprocessing_batch.m ..................................................................................................................... 1
Preprocessing_batch_job.m .............................................................................................................. 1
SPM Introduction

SPM Introduction

a) SPM has 3 main windows:
b) To process data you can use the first window and select each step individually or you can use the “batch” function from the Menu or Graphics window.

c) The Batch Editor will open in a new window. The window can be stretched/resized to see all information. An “<X” means you need to enter data for this line. Use the mouse to select each line.
Information on the batch interface can be found in the SPM8 manual.pdf chapter 42

i) Adding to the Batch
(1) Processes can be added, deleted & replicated in the batch but the order is determined by the order it is added to the script, appending to the end. It cannot be reordered manually.
   (a) Different stages can be saved separately & loaded together to create a full script.

ii) Saving & Editing Batch files. I recommend saving each batch you run for later editing and/or checking of work.
   (1) File -> Save Batch or the Save button
   (2) File -> Save Batch & Script: use this option if you plan on doing advanced editing in matlab
       (a) Useful for mass edit & replace of file names/locations
       (b) Output: filename.m & filename_job.m
          (i) You must edit the number of runs in filename.m for the file to run.
          (c) Edit .m file in matlab editor
             (i) Once a template has been made enter the information for 1 subject
             (ii) Open filename_job.m file in matlab editor
                 1. Edit replace file locations for each subject (subject directory)
                 2. Save filename_job.m file with
       (d) Run script:
          (i) Matlab prompt: run filename.m
          (ii) Batch window
             1. load filename.m (multiple files can be loaded at once) and it will automatically start the script, not necessary to load filename_job.m
             2. load filename_job.m (multiple files can be loaded at once) and you can view and edit batch before running/executing it

iii) Loading a saved batch file
     (1) File -> load batch or the Open folder button

iv) Clearing batch:
    (1) Clear all information: select “new” or new icon on toolbar
    (2) Clear selected files: while on procedure of interest: Edit -> Clear Value
Using SPM

a) Navigating within SPM & Matlab
   i) ./ = this directory
   ii) ../ = up 1 directory
   iii) * = include all files
       (1) Example: con_001*.img

b) File section window
   i) Directory paths
      (1) Dir: can type on this line to change the directory
      (2) Up: can folders up in that path (example from above: Users/pamelalamontagne/Desktop)
      (3) Prev: select previously visited directories
         (a) Stores information from the currently opened SPM session
         (b) To clear close & reopen SPM
      (4) Working directories can be changed in matlab
   ii) Select all or unselect all files
       (1) Windows & Linux: right click
       (2) Macs: ctrl + left click mouse, move cursor before unclicking mouse
       (3) When changing selected files remember to unselect previously selected files.
iii) Selecting nii files
   (1) Select nii file, & all timepoints
      (a) Filter: ^filename
         (i) ^ start of a string
         (ii) $ end of a string
         (iii) . any character
         (iv)
      (b) Specify timepoints: 1:1000 (can set above available timepoints)
   (2) Ed: you can use this option to change selected file information (changing a
      2 to a 3…)
   (3) Rec: recursively select files with current filter in all subdirectories of
      current location

c) SPM Terms:
   i) TR = time for 1 collection of all slices (usually 2500ms)
      (1) # of TRs = # of volumes = # of scans
         (a) These terms are used interchangeably in the field
         (b) TR will refer to time length
         (c) # of TRs will be verified by imbedded data in the Dicom and Nifti files.
            If the number of files does not match SPM will crash. If this happens
            start with the conversion step again.
   ii) Session: this refers to 1 scan/run (ex: 7 or 8). It does not refer to all runs
       together.
      (1) These steps require processing of individual sessions:
         (a) DICOM conversion
         (b) Slice Timing
         (c) Realignment
         (d) Analysis
      (2) These steps can be run with all sessions together:
         (a) Normalization
         (b) Smoothing

Order of Preprocessing
Preprocessing can be done in a few different ways

a) Direct Normalization
   i) Realign -> Slice Time* -> Normalization -> Smoothing
b) Indirect Normalization
   i) Realign -> Slice Time* -> Coregistration -> Segmentation -> Normalization ->
      Smoothing
c) *Slice Timing is an optional step. The order of slice timing depends on the amount of movement and the slice acquisition order (sequential vs. interleaved, WUSTL data = sequential). See notes below.

Figure 42.3: Flow chart for batch
PREPROCESSING

Basic IO
BasicIO provides several general operating processes that are convenient for processing more than one subject

a) Move/Delete Files: move to, copy to, move & rename, copy & rename, delete
b) Change Directory
c) Make Directory
d) File Selector (Batch Mode):
   i) Specify a directory to retrieve files from
   ii) Specify filter to select files: ^f
e) File Set Split: specify which files belong to which runs (run1=1:192, run2=193:384)
f) Run Batch Jobs: allows you to enter information for Batch jobs in the GIU

Convert files to SPM format
a) Files from the scanner are in DICOM format, which equals 1 file per slice per timepoint (#volumes * #slices).
   i) Nifti format: SPM uses Nifti format (neuroimaging format) which produces 1 *.nii file that contains all timepoint. (**Current conversion from Siemens Trio DICOM files with nii selection results in 1 .nii file per timepoint.)
   ii) Analyze format: Alternatively, data can be in *.img & *.hdr format which will result in 1 .img & 1.hdr file per timepoint.
b) DICOM Import
   i) Select Dicom files to convert (“select all”)
   ii) “done”
   iii) Select folder to put converted files in (this should be a standard location for all runs of a subject)
c) Batch:
   i) Select BATCH
   ii) Select SPM -> Util -> Dicom Import
      (1) Click on “Dicom files”
         (a) “select files” (at bottom of screen)
      (2) Click on “Output Directory”
         (a) “select files” (at bottom of screen)
   iii) File -> save batch
   iv) Click on green arrow at top of screen to run batch or input next step in the batch
   v) Output: f*.nii
Slice Timing
Slice timing accounts for acquisition timing. This step is sometimes considered optional in the processing stream. The order of slice timing, before or after realignment, depends on your data. If you have acquired slices in sequential order and have little movement then you should do realignment first: correct for the movement and then account for the timing of acquisition. If you have acquired slices in sequential order and have lots of movement run slice timing first and then realignment: it is likely that the slice timing will correct for the wrong slice if there is a lot of movement and it has been corrected for. Interleaved slice acquisition: debatable whether to use slice time correction especially with large movement. If you plan on running a DCM analysis you must run slice timing.

a) Temporal: Slice Timing
   i) Session: select data for each session individually, do not combine across a subject
   ii) # of slices: 26
   iii) TR: 2.5 seconds
   iv) TA: 2.5-(2.5/26)
   v) Slice order
      (1) Interleaved Slice order:
          (a) bottom->up
          (b) 1:2:26 2:2:26
          (c) Reference slice: the middle acquired slice during the TR (ex.: 13 or 2)
      (2) Sequential Slice order:
          (a) Ascending (Bottom->up): [1:1:nslices] (ex.: 1:1:26)
          (b) Descending (Top->down): [nslices:-1:1] (ex.: 26:-1:1)
          (c) Reference slice: middle slice (ex.: 13)

b) Output
   i) a*.img & .hdr for each image or a single a*.nii file for the entire run

Realignmemt
The realignment step corrects for motion across and within sessions of an individual subject. Acceptable movement is up to 6mm, however, with the realignment step and inclusion of the text output even the most extreme movement can be controlled for. With SPM all timepoints must be included. Timepoints with large movement cannot be removed as they can be with other programs but use of the ART program can specify movement and signal outliers as a regressor to be included at the 1st level.

a) Spatial: Realign: Estimate & Reslice
   i) Estimate only: no new images that are resliced, only estimated parameters written to files
b) Add number of sessions per scan

c) Select files for each session (ex. 201, then 301, then 401)

d) Defaults:
   i) Resliced images: mean only

e) Output:
   i) mean*.nii: mean image of all sessions for this subject
   ii) Filename prefix: r
      (1) If you select reslice images & mean this will be the prefix applied to the output
   iii) rp_session1.txt: this file contains information of the mm of motion correction for each slice for translation (x,y,z) and rotation (roll, pitch, and yaw) dimensions per run/session

Coregistration
This step is included for indirect normalization. Since EPI data is not as detailed as the structural T1 images this option allows for a better normalization to the MNI template. In this step you will coregister the individuals T1 to their EPI.

   a) Spatial: Coregister: Estimate & reslice
      i) Reference image: This image does not move
         (1) Mean EPI image
      ii) Source Image: This image is the one that will move
         (1) T1 image

Segmentation
This is the second step in indirect normalization. This will segment the T1 image into CSF, white matter, & grey matter. Segmentation is based on the MNI template; therefore this step must calculate the transformation before segmenting. These calculations will be used to in the next step of normalization of the EPI images.

   a) Spatial: Segmentation: Estimate
   b) Data: coregistered T1 volume
      i) Dependency: coregistration output
   c) Sampling size: if using a T1 image that has small voxel size in raw format change from 3 -> 2
   d) Output files: coordinate transformation
      (i) Optional: grey, white, csf
      (ii) Default: native
      (iii) If doing VBM analysis: native + modulated + unmodulated
   e) Optional: New Segment
Normalization

The normalization step warps each individual subject into standard space based on the MNI template. More than one subject can be entered into 1 normalization step. If you choose to use the direct normalization you do not have to run the coregistration & segmentation steps.

a) Direct normalization
   i) Spatial: Normalization: Estimate & write
   ii) Source image: mean image from realignment step
       (1) Dependency-> realign: estimate & reslice: mean image
   iii) Images to write: all resliced images across all sessions
       (1) Dependency-> realign: estimate & reslice:
           (a) mean image
           (b) Resliced (sess1)
           (c) Resliced (sess 2)
           (d) Use the ctrl key to select more than one image
       (2) Template image: EPI.nii
           (a) Select files should automatically open the template folder
           (b) Found in : spm8/templates
   iv) Do not change defaults
   v) Output:
      (1) Filename prefix: w
      (2) All images & mean image will be normalized

b) Indirect normalization
   i) Spatial: Normalization: write
   ii) Parameter File: (Dependency) output of segment: subj->MNI
   iii) Images to write: all slice time & realigned images across all sessions
       (1) Dependency-> slice time or realignment output (whichever was last):
           (a) mean image
           (b) Realigned (sess1)
           (c) Realigned (sess 2)
           (d) Use the ctrl key to select more than one
   iv) Bounding Box: default does not include all of cerebellum
      (1) Default: -78, -112, -50
      (2) Change to: -78, -112, -70

c) Structural normalization (after indirect normalization)
   i) Spatial: Normalization: write
   ii) Parameter File: (Dependency) output of segment: subj->MNI
iii) Images to write: (Dependency) output from Coregistration

**Smoothing**
The smoothing process applies a smoothing filter to the images. This helps with subject spatial differences especially when it comes to group analysis. If there is a specific region you are interested in, sensitivity can be optimized by smoothing to the diameter of that region. However, remember that all regions are not the same size and this may affect other regions.

a) Spatial: Smooth
b) Images to smooth
   i) Dependency -> Normalize output
      (1) normalize: estimate & write: normalized images subject 1
      (2) All subjects/sessions can be smoothed at the same time

c) FWHM
   i) Edit value: enter a vector of 3 numbers, usually the same smoothing filter in all dimensions
      (1) [8 8 8]
         (a) a minimum of 2voxel diameters (or widths)
         (b) minimum of 6mm
   ii) Output: Filename prefix: s
SUBJECT LEVEL ANALYSIS

1st level analysis
In this step we specify the design and the contrasts at the individual subject level. At this stage we enter all the information about different conditions, onsets and durations for all the scans combined across a subject. After the model has been specified it must be “estimated”. For Block design studies I suggest creating a template with onsets/durations. For Event design I suggest using the “multiple conditions” option which allows for the uploading of a *.mat file that contains all the condition information. Multiple conditions can be used for either design but most useful for event design where a lot of information is being entered.

fMRI model specification
i) Directory: select separate output directory for each analysis
   (1) Suggestion: “results” or “results1”
ii) Timing Parameters
(1) Units for design: seconds or scans
   (a) If the onsets from e-prime select seconds
(2) Interscan interval: TR length in seconds (2.5)
(3) Microtime resolution: # of bins (aka. # of slices), go with defaults
(4) Microtime onset: reference slice the bin at which you are specifying, go with defaults

iii) Data & Design
   (1) Click on “New: Subject/Session
      (a) You will need one of these for each session (run), remember that this step is only doing 1 subject at a time.
      (b) Select smoothed images (s.*) for each session. If using nii files be sure to filter (1:1000) so you include all timepoints
   (2) Conditions
      (a) Individual entry
         (i) Click on “New: Condition”
         (ii) Edit Value
         (iii) Name: enter name of condition
              1. This should be in the same order across subjects and does not need to follow the presentation order
         (iv) Onset:
              1. enter onsets in for the condition separated by a space
              2. these can be copied (ctrl+c) and pasted (ctrl+v)
         (v) Durations
              1. If constant: enter 1 value
              2. If variable: there should be equal number of onsets and durations
      (b) Multiple Condition
         (i) This step allows you to use a .mat file that contains all the relevant information rather than entering it in the batch script.
   (3) Regressors:
      (a) Realignment parameters (movement) can be entered by loading the rp_subj#_run#.txt file for each run
      (b) If concatenating across all runs you must specify a regressor that indicates session (n-1 regressors: if you have 6 runs specify a regressor for runs 1-5, 6 is then implied). It should be binary so a 1's for run1 and 0's for all other timepoints. Session2= 1’s for session2 timepoints
   (4) Don’t change defaults
**Model estimation**

a) Select SPM.mat file
   i) Dependency: fMRI model specification: SPM.mat

**Contrasts:**

Contrasts are entered on an individual subject & session basis, useful if each subject does not have the same conditions across all sessions, or they can be entered at the end and replicated if the conditions are consistent across subjects and sessions. I recommend first specifying a t-contrast for each condition individually then using a factorial design at the group level. In addition, if you want to do group comparisons enter the specific contrast desired (cond1 vs cond 2) at the individual level as well.

1. Individual subject level
   a) Select SPM.mat file
      i) Dependency: Model Estimation: SPM.mat
      ii) OR select SPM.mat file specific to the subject
   b) New: F-Contrast
      i) Specify an F-contrast for all conditions so that you can later examine activity in a region relative to each task (i.e., plot activity for that region by condition)
1. Name: effects of interest
   2. Specify a 1 for each condition and the rest as 0 with 1 line per condition:
      
      1 0 0 0
      0 1 0 0
      0 0 1 0
      0 0 0 1

   (c) New: T-Contrast
      (i) Enter appropriate name for contrast (ex: cond1 or cond1-cond2)
      (ii) Enter the contrast desired (ex: 0 1 0 0 0 1 0 0 0 1 0 0 )
      (iii) Be sure that there is a number for each condition across all runs
         1. Replicate: If conditions are the same across runs specify the contrast for the first run (ex: 0 1 0 0) and select replicate
         2. You must take into account any regressors included in the model specification. You will specify all regressors as 0. If you are replicating you can leave the last columns blank
      (iv) If comparing 2 or more conditions at the subject level the contrast must equal 0 (ex: 0 1 0 -1 or .5 .5 0 -1)

   (d) Editing existing contrasts: If you prespecified contrasts and made an error you can edit & rerun the contrast file but be sure to select “delete existing contrasts.” Otherwise the new contrasts will be added after the existing ones

Printing Results
There is an option in the batch mode to print the results of any contrast specification.

   a) Batch -> Stats -> Report Results
      i) Select SPM.mat file
      ii) Contrast Query:
         (1) Contrasts: Inf will give all contrasts from this SPM.mat file
         (2) Threshold: FWE & p<.05 or none (uncorrected) & p<.001
            (a) The p-values can be adjusted

Multiple conditions file for 1st level design specification
For 1st level design specification you can manually enter names, onsets, & durations for each condition & run or you can select a mat file that includes an array of all names, onsets & durations. You will need a multiple conditions file per run/session you specify.

Creating a Multiple condition file
   • Create a skeleton array that includes the names & durations pre-specified.
      o Use {} to specify the arrays. All parts will be grouped based on {n}.
         ▪ names {1} = cond1
- names \{2\} = cond2
- durations \{1\} = 0
- durations \{2\} = 0

- Durations
  - Event = 0
  - Block = duration of block

- The following example scripts are based on preexisting afni onset files.
  - A script can be written to extract onsets from other formats as well.
  - The arrays should look like the following images
Examples of Matlab scripts for getting onsets into multiple conditions file

%%%%%%%%%%%%%%%%% EVENT SPM PM REGRESSOR SCRIPT %%%%%%%%%%%%%%%%%%%%%%
%%THIS SCRIPT MAKES INPUT REGRESSORS FOR SPM BASED ON THE AFNI PM AFNI
%%%EVENT REGRESSORS AS INPUTS

function [onsets, names, durations]=reg_trans_SPM(subjs)

%%%%DEFINE SUBJS & INPUT DIRECTORY
%subjs=[1009211];

%%%%STATIONARY VARIABLES
runs=[0,3,5,15];
counter=1;

%%%%LOAD EVENT TEMPLATE WITH DURATIONS AND HEADER NAMES
load multi_cond_event.mat
for subj=subjs
    for run=runs
        %%%LOAD AFNI INPUTS
test=sprintf('load subj%d_%d_globaltimes.txt', subj,run);
eval(test)

%%%SAVE ONSETS (EACH COL= DIFFERENT CONDITION)

test2=sprintf('onsets{counter}= transpose(subj%d_%d_globaltimes)',subj,run);
eval(test2);
counter=counter+1;

end

end

%%%SAVE MAT FILE WITH OUTPUTS

outputname=sprintf('save subj%d_trans_spm.mat onsets names durations',subj);
eval(outputname);
GROUP ANALYSIS

2nd level analysis
See Ch.10 in the SPM Manual for detailed information on factorial design specification.

Specify Design

ii) Choose: Factorial design specification

iii) Design: Choose from the appropriate analysis you want to run and follow the instructions below.

iv) One-Sample T-test: contrasts selected should be a comparison at the 1st level (ex: fearful-left > fearful-right)
(1) Select the appropriate con_000* files from the individual subject folders
(2) Select output directory

v) Two-sample t-test: This design is for between-subjects comparisons. Contrasts selected should be a comparison at the 1st level (ex: fearful-left > fearful-right)
(1) Group scans: Select the appropriate con_000* files from the individual subject folders
(2) Be sure to enter the files for grp1 and then for files for grp2 separately
(3) Select output directory

vi) Paired t-test: This design is for with-in group comparisons (time1 vs time2). Contrasts selected should be a comparison at the 1st level (ex: fearful-left > fearful-right)
(1) Pairs: select the contrast of interest for an individual at time1 & time 2
(2) The number of pairs should match the number of subjects
(3) Select output directory

vii) Multiple Regression: This step allows you to run a One-sample t-test with a covariate/regressor
(1) Select the appropriate con_000* files from the individual subject folders
(2) Covariates:
   (a) enter 1 value per subject
   (b) Multiple covariates can be entered.
(3) Select output directory
viii) **Full Factorial**: contrasts selected should not be a comparison at the 1st level but rather represent a single condition (ex: fearful-left)

1) Factors: New Factor
   a) Enter the number of factors
   b) Name each factor (valence / location)
      i) Can be used to specify a condition or group
   c) Enter the number of levels for each factor (2x3 or 3x4)

2) Specify Cells: New Cell
   a) Enter the level of the cell as a vector (ex: 2 1)
   b) Select the appropriate con_000* files from the individual subject folders

3) Select output directory

**Model estimation**

a) Select SPM.mat file
   i) Dependency: fMRI model specification: SPM.mat

**Contrasts**
Contrasts also need to be specified for 2nd level (group) analysis similar to 1st level (individual subject) contrasts. Refer to the design matrix to determine column assignment.

a) T-tests
   i) Specify contrast name: cond1-cond2 or grp1cond1-grp2cond1
   ii) Specify contrast: 1 -1

b) Factorial Analysis
   i) Specify contrast name: cond1-cond2
   ii) Specify contrast: the same rules apply as at the subject level:
      (1) Specify a number for each condition/column
      (2) Each side should add to 1/-1 (ex. .333 .333 .333 -.5 -.5)

**Results**

**Viewing Results**
In the latest version of SPM (SPM8) viewing different contrasts and changing thresholds is more user friendly and one can easily switch back and forth. For results you will mainly be using the lower-left window to navigate and the graphics window to view.

a) Results
   i) Select SPM.mat
   ii) Select contrast of interest
   iii) Apply mask
(1) ROI
(2) Contrast
(3) Other?
iv) Threshold:
   (1) Corrected: FWE (Family-Wise Error) default set to p < .05
   (2) Uncorrected: None default set to p < .001
   (3) Voxels: k = minimum number of voxels per significant cluster
      (a) This will vary depending on region of interest (visual cortex vs amygdala)

b) Switching to a new contrast or threshold
   i) You will now see a Contrasts drop-down on the lower-left window.
   ii) Options:
      (1) Contrasts: previous contrast, next contrast, list of contrasts to pick from, new contrast
      (2) Threshold: FWE/p < .05/0 voxels, uncorrected/p < .001/0 voxels, specify threshold

**Significance Table**
a) Whole Brain
   i) This will output all the significant clusters with coordinates, FEW, FDR & uncorrected significance levels, and # of voxels per cluster.
   ii) Clicking on coordinates will move cursor in glass brain

b) Current cluster: gives information for sub-clusters, useful for large clusters

c) Print Text Table: right click table in the graphics window
   i) Output in matlab window
   ii) Copy & paste to excel

**Overlay Images**
Overlay options allow you to view the data on axial slices (slices), 2D image (section), or 3D image (render). Template files are found in the main spm8 folder which is listed at the top of the file selection drop-down.

d) Glass Brain
   i) At the top you will always see a glass brain of the significant activity. To navigate drag the red arrow to the desired location. This will move in sync with section & render overlays.

e) Sections:
   i) spm8/canonical/ or individual T1 (MPRAGE)
   ii) simply click around the image to navigate the image
iii) previous section: after switching contrasts use this to quickly use the previously used render template

f) Render
   i) spm8/canonical/cortex*
   ii) rotate with mouse
   iii) right-click options
       1) inflate: smooths out gyri
       2) transparency
       3) hemispheres (components)
       4) save as: giff files
   iv) previous render: after switching contrasts use this to quickly use the previously used render template

Plot
   a) Contrast Estimates % & 90% Confidence interval
      i) Select contrast: effects of interest
   b) Fitted Responses: Plots adjusted data & fitted responses across session/subject
      i) Typing “Y” in the matlab window will give fitted response data, “y: gives adjusted data
Batch Script Processing

Batch processing can be done through the GIU or through Matlab scripts.

GIU Batch

1) Create a batch in the GIU by adding all desired processes in chronological order.
   a) Dependency: selects output files from previous steps
   b) The order of steps cannot be reordered in the GIU
      i) You can Delete steps or Replicate steps with right mouse button

2) Creating Templates: Once you have specified subject specific data and dependencies
   a) Clear Data: right click and clear subject specific data
   b) Save template
   c) Load batch and enter subject specific data
      i) **Recommendation**: use Basic IO: file selector (Batch mode)
         (1) Subject specific data will the be a directory
Script Batch (Advanced)

3) Create a batch in the GIU by following steps about.
   a) Save as Batch & Script (example file name: template_preprocess_batch)
   b) Output: template_preprocess_batch.m & template_preprocess_batch_job.m
      i) template_preprocess_batch_job.m: contains information for all steps and
         information specified in the GIU
         (1) This file can be loaded in the GIU and edited
         (2) Changes can be made to this script in matlab (such as replace all or
             changing file names for regressors/conditions)
         (3) '<UNDEFINED>': This indicates that an input needs to be specified in the
             other file or the GIU
      ii) template_preprocess_batch.m:
           (1) this matlab file includes a path to the job(s) to complete
               (template_preprocess_batch_job.m
           (2) Inputs: These represent each unidentified variable in the *_job.mat file
               (a) These can be entered using matlab functions such as string replace
                   (strrep) or sprintf

   c) Running a Batch Script (2 options)
      i) GIU: open SPM & Batch window -&gt; load template_preprocess_batch.m
      ii) At Matlab prompt:
           (1) load /usr/local/pkg/spm8/matlabbatch/matlabbatch.man
           (2) template5_session_regressor_batch